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1 Product Features

1.1Product overview

IOL7 series master IP67 module is an IO-Link master device with standard IO structure, supporting

EtherCAT and PROFINET industrial Ethernet bus interface on the bus side, and IO-Link protocol on the

user side, and it is a gateway device belonging to the bus slave as well as the IO-Link master. Both the bus

interface and the IO-Link interface can be interfaced with devices from multiple vendors with high

compatibility, providing a variety of choices for user data acquisition, optimizing system configuration,

simplifying on-site wiring, and improving system reliability.

1.2Product Features

 Up to IP67 protection

Suitable for harsh industrial environments

 Standardization

Based on IO-Link standard V1.1.3, IO-Link slave devices can be remotely controlled for easy

operation.

 High compatibility

Supports slave devices with special process data lengths

 Compactness

For applications where space is at a premium

 Easy diagnosis

Innovative channel indicator design, close to the channel, channel status at a glance, easy to

detect and maintain

 Easy configuration

Simple configuration and support for all major PLCs.

 Easy and fast wiring

Simple wiring with standard cables
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2 Designation Rules

2.1Designation Rules

Serial

number

Definition Description of values

(1) Product

Technology

IOL: short for IO-Link

(2) protection class 7: IP67

(3) bus protocol EC: EtherCAT protocol abbreviation

PN: PROFINET protocol abbreviation

EI: Abbreviation for EtherNet/IP Protocol

(4) Product Serial

Number

01: Serial number of product series

(5) Signal Type A: NPN

B: PNP

(6) I/O Interface 8A: 8 x Class-A ports

4A4B: 4 x Class-A ports, 4 x Class-B ports

8B: 8 x Class-B ports
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2.2Model List

Model Product Description

IOL7-EC01B-8A EtherCAT bus protocol 8 x Class-A ports for IO-Link masters

IOL7-EC01B-4A4B EtherCAT bus protocol 4 x Class-A, IO-Link master with 4 x Class-B ports

IOL7-EC01B-8B IO-Link master with 8 x Class-B ports for EtherCAT bus protocols

IOL7-PN01B-8A PROFINET bus protocol 8 x Class-A ports for IO-Link masters

IOL7-PN01B-4A4B PROFINET bus protocol 4 x Class-A, IO-Link master with 4 x Class-B ports

IOL7-PN01B-8B PROFINET bus protocol 8 x Class-B ports for IO-Link masters

IOL7-EI01B-8A EtherNet/IP bus protocol 8 x Class-A port IO-Link masters

IOL7-EI01B-4A4B EtherNet/IP bus protocol 4 x Class-A, IO-Link master with 4 x Class-B ports

IOL7-EI01B-8B IO-Link master with 8 x Class-B ports for EtherNet/IP bus protocols
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3 Product Parameters

3.1General parameters

Interface parameter

bus protocol EtherCAT, PROFINET, EtherNet/IP

bus interface 2 x M12, 4Pin, D-code, Blue

electrical isolation 500 V

Number of I/O stations According to the master station

data transmission

medium

Category 5+ UTP or STP (STP recommended)

transmission distance ≤100 m (station to station)

transmission rate 100 Mbps

Technical Parameters

Configuration Through the master

Power connector 2×M12, 5Pin, L-code, Red

power supply
18~36VDC

Reverse polarity protection

US Total current Max: 16A

US Current consumption ≤100mA

UA Total current Max: 16A

UA Current consumption 0mA

Electrical isolation

between US and U A

be

weights 480g

sizes 225×62×35.1mm

operating temperature -25~+70℃

Storage temperature -40~+85℃

relative humidity 95%, non-condensing

protection class IP67
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3.2Digital parameter

3.2.1 EtherCAT Bus Module Parameters

Product Model IOL7-EC01B-8A IOL7-EC01B-4A4B IOL7-EC01B-8B

bus protocol EtherCAT

rated voltage 24 VDC (±25%)

DI/DO/IO-Link Interface 8×M12, 5Pin,

A-code

4×M12, 5Pin, A-code

4×M12, 5Pin, B-code

8×M12, 5Pin, B-code

Number of IO-Link channels 8

IO-Link version V1.1

IO-Link Transfer Rate COM1 (4.8kbps), COM2 (38.4kbps), COM3 (230.4kbps)

Number of input channels Maximum 16 Maximum 12 Maximum 8

Input Signal Type PNP

Input Filtering Supported, fixed configuration is 3ms

Input Current 200 mA

Maximum number of output

channels

Maximum 8 Maximum 8 Maximum 8

Maximum output current for a

single channel

1.6A

Output Signal Type PNP

Load Type Resistive loads, inductive loads

Total output current US , UA 16 A max.

port protection overcurrent protection

Isolation method UA Not used US and UA isolated

Channel Indicator Lights Supported
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3.2.2 PROFINET bus module parameters

Product Model IOL7-PN01B-8A IOL7-PN01B-4A4B IOL7-PN01B-8B

bus protocol PROFINET

rated voltage 24 VDC (±25%)

DI/DO/IO-Link Interface 8×M12, 5Pin, A-code 4×M12, 5Pin, A-code

4×M12, 5Pin, B-code

8×M12, 5Pin, B-code

Number of IO-Link

channels

8

IO-Link version V1.1

IO-Link Transfer Rate COM1 (4.8kbps), COM2 (38.4kbps), COM3 (230.4kbps)

Number of input

channels

Maximum 16 Maximum 12 Maximum 8

Input Signal Type PNP

Input Filtering Supported, fixed configuration is 3ms

Input Current 200 mA

Maximum number of

output channels

Maximum 8 Maximum 8 Maximum 8

Maximum output current

for a single channel

1.6A

Output Signal Type PNP

Load Type Resistive loads, inductive loads

Total output current US , UA 16 A max.

port protection overcurrent protection

Isolation method UA Not used US and UA isolated

Channel Indicator Lights Supported
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3.2.3 EtherNet/IP Bus Module Parameters

Product Model IOL7-EI01B-8A IOL7-EI01B-4A4B IOL7-EI01B-8B

bus protocol EtherNet/IP

rated voltage 24 VDC (±25%)

DI/DO/IO-Link Interface 8×M12, 5Pin, A-code 4×M12, 5Pin, A-code

4×M12, 5Pin, B-code

8×M12, 5Pin, B-code

Number of IO-Link

channels

8

IO-Link version V1.1

IO-Link Transfer Rate COM1 (4.8kbps), COM2 (38.4kbps), COM3 (230.4kbps)

Number of input

channels

Maximum 16 Maximum 12 Maximum 8

Input Signal Type PNP

Input Filtering Supported, fixed configuration is 3ms

Input Current 200 mA

Maximum number of

output channels

Maximum 8 Maximum 8 Maximum 8

Maximum output current

for a single channel

1.6A

Output Signal Type PNP

Load Type Resistive loads, inductive loads

Total output current US , UA 16 A max.

port protection overcurrent protection

Isolation method UA Not used US and UA isolated

Channel Indicator Lights Supported
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4 Panel

4.1Product structure

Name of each part of the product
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4.2Indicator light function

Name markings color state of

affairs

State Description

Network

indicator IN

L/A1 GREEN GREEN establish a network connection

FLASHING Network connection with data interaction

OFF No data interaction or exception

Network

indicator OUT

L/A2 GREEN GREEN establish a network connection

FLASHING Network connection with data interaction

OFF No data interaction or exception

System power

indicator

US GREEN GREEN Power supply is normal

OFF The product is not powered up or the power supply

is abnormal

Auxiliary

power

indicator

UA GREEN GREEN Power supply normal

OFF The product is not powered up or the power supply

is abnormal

Operation

status

indicator RUN

R GREEN GREEN Normal operation of the system

FLASHING 2Hz: the device is in Pre-OP state

1Hz: device is in Safe-OP state

OFF Device is in Init or unpowered state

warning

indicator

(EC master

reserved)

E RED GREEN Abnormal system operation

FLASHING Device is down or slave is misconfigured

OFF System running normally or not powered up

warning

indicator

(PN master)

SF RED GREEN PROFINET master system working abnormally

OFF PROFINET master system running normally or not

powered up

BF RED GREEN PROFINET master network connection abnormality

OFF PROFINET master network connection is normal

Pin2 Channel

Indicator

1 GREEN GREEN Module channels have signal inputs

OFF No signal input or abnormal signal input on

module channel

Pin4 channel

indicator

0 GREEN GREEN Module channel has signal output high or input

high, IO-Link module normal

FLASHING IO-Link module status abnormal

OFF Module channel has signal output low or input low
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4.3Bus Interface Definitions

Bus Interface Connection View (M12, D-code,

Hole End)

Description of definitions

Pin functionality

1 TX+, data for transmission+

2 RX+, data for reception+

3 TX-, Data for Transmission-

4 RX-, data for reception-

4.4Power Connector Definition

Power connector connection view (M12,

L-code, pin end & hole end)

Description of definitions

Pin Functionality Core Color

1 +24V US Brown

2 0V GNDA White

3 0V GNDS Blue

4 +24V UA Black

5 PE Gray
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4.5I/O Connector Definitions

I/O Connector Connection View (M12,

A-code/B-code, Hole End)

Description of definitions

Pin Functionality Core Color

1 +24V US Brown

2 DI/DO/+24V UA White

3 0V GNDS Blue

4 DI/DO/IO-Link Black

5 PE/0V GNDA Gray

Precautions

 Series 01 Pin2 can only be used as a DI.

 All Class-A interfaces of the 01 series Pin1 and Pin3 are powered from the system power supply US ,

and Pin4 signal output power is also provided by US .

 All Class-B interfaces of the 01 series Pin2 and Pin5 are powered from the auxiliary power supply UA ,

and Pin4 signal output power is provided by US .
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5 Installation and wiring

5.1Dimensions

Housing specifications (unit mm)
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5.2Installation Environmental Requirements

To fully utilize the performance of the IOL7 module and enhance its reliability, avoid installing it in the

following locations:

 location under direct sunlight

 Locations where ambient temperature or relative humidity exceeds module specifications

 Places with corrosive gas, flammable gas

 Places with acid, oil, chemical droplets

 Places where there are dust, iron chips, sparks splash

 Places where the module body is directly exposed to shocks and vibrations.

 Places with strong electric and magnetic fields, radiation and static interference

 Places with power lines and AC strong wires nearby

5.3Module Installation

 Please use screws of M4*22mm or above to fasten and install the module body.

 The mounting hole dimensions for the module are shown below.

Precautions

 The transparent cover on the module is the reserved cover for the rotary switch, which is fastened at

the factory, so please do not disassemble it to avoid damaging the IP67 protection level.

 Please fix the module correctly, if it is not fixed securely it may fail due to vibration.
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5.4Wiring instructions

5.4.1 Power connector wiring diagram

caveat

 It is recommended that the system power supply and auxiliary power supply are powered by different

switching power supplies to ensure the stability of operation.

 Refer to the "Power Supply Rules" section for power supply rules.

5.4.2 I/O Interface Wiring Diagram

PNP Input PNP Output

three-wire system two-wire system
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Precaution

 Please install the module's matching waterproof cap on the unused connector interface and tighten it

so as not to jeopardize the IP67 protection rating.
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6 Power supply rules

6.1Direct power supply rules

The power supply for each module is connected directly from the switching power supply without

using the OUT connector. The total current consumption of each module's auxiliary power supply should

be ≤16A.

The voltage drop in the power supply cable varies depending on the total current consumption of the

module's auxiliary power supply and the cable material, and the following table shows the voltage drop

when using our standard cables.

Total current

consumption of the

power supply (A)

Voltage drop at different cable lengths (V)

1m 3m 5m 10m

8 0.64 1.12 1.60 2.72

7 0.56 0.98 1.40 2.38

6 0.48 0.84 1.20 2.04



IOL7 Series Master User's Manual 6 Power supply rules

17 Copyright © 2024 Nanjing Solidot Electronic Technology Co., Ltd.

5 0.40 0.70 1.00 1.70

4 0.32 0.56 0.80 1.36

3 0.24 0.42 0.60 1.02

2 0.16 0.28 0.40 0.68

1 0.08 0.14 0.20 0.34

 Example of calculation of total module current consumption with direct power supply

For example, both modules are IOL7-EC01B-8A, and each module is used as shown in the table below:

Module

name

I/O Ports Externally connected devices

port

name

Pin

Name
I/O Mode brand name norm

Module 1 Port 1~8

Pin4
DI (input current

4mA)
3 Wire Sensors

Current consumption:

30mA

Pin2
DI (input current

4mA)

Current consumption:

30mA

Module 2 Port 1~8

Pin4 DO solenoids Load current: 500mA

Pin2 DI
3 Wire

Sensors

Current consumption:

30mA

Calculate the total consumption current and the individual module calculation current as shown in the

table below:

Module

name

Power

supply type

Total Consumption Current

Calculation Items

calculation result

Module 1

System

power

supply US

System consumption current

Module system side power consumption

35mA

System

power

supply US

Module input current and

sensor consumption current

For all ports

(Sensor consumption current) + (Channel

input current * Number of input points)

= (30mA * 16) + (4mA * 16)

= 544 mA

Module 2

System

power

supply US

System consumption current

Module system side power consumption

35mA

System

power

supply US

Module input current and

sensor consumption current

For port 1~8 Pin2

(Sensor consumption current) + (Channel

input current * Number of input points)

= (30mA * 8) + (4mA * 8)

= 272 mA
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Load Output Current

For port 1~8 Pin4

Channel Output Current * Number of

Output Points

= 500mA * 8

= 4A

In summary, the current consumption of each module is as follows:

 For the system power supply US , each module consumes a current of 35mA.

The auxiliary power supply UA for module 1 (IOL7-EC01B-8A) consumes 35 mA + 544 mA = 579 mA,

which is less than the module auxiliary power supply UA maximum current of 16A.

The auxiliary power supply UA for module 2 (IOL7-EC01B-8A) consumes 35 mA + 272 mA + 4A =

4.307A, which is less than the module auxiliary power supply UA maximum current of 16A.

In this example, the requirement is satisfied because the total consumption current total of each module

satisfies the sum of the module auxiliary power supply consumption current ≤ 16A.
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6.2Tandem power supply rules

Modules are supplied in series with each other through the OUT interface. The total consumption

current of the auxiliary power supply of each module should be ≤16A, and the total consumption current

of the system power supply and auxiliary power supply of all modules should be ≤16A.

When power is supplied in series, the module will have the consumption current of the

series-connected module flowing inside the module, thus generating a voltage drop in the internal circuit

of the module. The voltage drop in the power cable varies according to the total consumption current of

the module's auxiliary power supply and the cable material, the following table shows the voltage drop

when using our standard cables.

Total current

consumption of the

power supply (A)

Voltage drop in the

internal circuit of the

module (V)

Voltage drop at different cable lengths (V)

1m 3m 5m 10m

16 0.64 1.28 2.24 3.20 5.44

15 0.60 1.20 2.10 3.00 5.10

14 0.56 1.12 1.96 2.80 4.76

13 0.52 1.04 1.82 2.60 4.42

12 0.48 0.96 1.68 2.40 4.08

11 0.44 0.88 1.54 2.20 3.74

10 0.40 0.80 1.40 2.00 3.40

9 0.36 0.72 1.26 1.80 3.06

8 0.32 0.64 1.12 1.60 2.72

7 0.28 0.56 0.98 1.40 2.38

6 0.24 0.48 0.84 1.20 2.04

5 0.20 0.40 0.70 1.00 1.70

4 0.16 0.32 0.56 0.80 1.36

3 0.12 0.24 0.42 0.60 1.02
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2 0.08 0.16 0.28 0.40 0.68

1 0.04 0.08 0.14 0.20 0.34

Precautions

 The total current consumption of the auxiliary power supply of each module shall be ≤ 16A.

 As shown in the above figure, the total consumption current of the system power supply and auxiliary

power supply of all modules in series should meet the rule of "1+2+3" ≤ 16A.

 Example of calculating the total current consumption of a module when powered in

series

For example, if both modules are IOL7-EC01B-8A, the usage of each module is the same as in the

"Example of Calculating the Total Current Consumption of a Module When Directly Powered".

Calculate the total consumption current:

US = 579mA + 4.307A = 4.886A

In this example, the requirement is met because the sum of the current consumption of the system

power supply US of all modules satisfies the rule "1+2+3" ≤ 16A.

Precaution

 Use of 4A4B or 8B models should take into account that the total consumption of the auxiliary power

supply for Class-B interfaces under both power supply rules is ≤ 16A.



IOL7 Series Master User's Manual 7 Operation

21 Copyright © 2024 Nanjing Solidot Electronic Technology Co., Ltd.

7 Operation

7.1Parameter description

7.1.1 Output clear hold function

The Clear/Hold function targets the output signals of each port, and this function can configure the

output action of the module in the abnormal state of the bus. Three types of operations are supported:

Low level output (Clear 0): when communication is disconnected, the module output channel outputs

a low level.

High Level Output (Clear 1): When communication is disconnected, the module output channel

outputs a high level.

Hold output: When the communication is disconnected (Hold last value), the output of the module

output channel always keeps the last state level.

 The EtherCAT master output clear hold function is configured using the TwinCAT3 software as an

example, see chapter 7.2.1 Parameter Configuration for details.

 The PROFINET master output clear hold function uses the TIA Portal V17 software as an example

to introduce the configuration method, see the master parameter configuration in chapter

7.3.1 for details.
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7.1.2 ISDU Remote Configuration Function

EtherCAT master supports ISDU read/write operation, PROFINET master only supports ISDU write

operation before configuration. Before the operation, you should get the information related to the ISDU

of the slave station, and the specific information can be viewed in the "IOL7 Series Hub User's

Manual_Vx.xx.pdf", Chapter 6 section.

The solidot slave IOL7-16CB-M12 supports the functions of configuring the port direction, input

filtering function, and restoring factory settings. The following is an example of how to configure these

three functions according to Port 1 connected to the slave IOL7-16CB-M12 with Port 1 status displaying 3

(IO-Link OP status).

1、 EtherCAT master ISDU parameter reading and writing

Example 1: Configure the first 8 channels of the IOL7-16CB-M12 as inputs and the last 8 channels as

outputs. Refer to section 6.5.2 of IOL7 Series Hub User Manual_Vx.xx.pdf, Index is set to 0x0042,

Subindex is set to 0x00, Length is set to 2 (0x02), Data is set to 00FF, and Control selects Write.

Example 2: Configure the first 8 channels of the IOL7-16CB-M12 for Input Filtering 3.2ms and the last

8 channels for Input Filtering Off. Refer to IOL7 Series Hub User's Manual_Vx.xx.pdf, section 6.5.8, Index

is set to 0x0049, Subindex is set to 0x00, Length is set to 0x10, Data is set to

05050505050505050808080808080808, and Control is selected as Write.

Example 3: Restore IOL7-16CB-M12 factory settings. Refer to section 6.3 of IOL7 Series Hub User

Manual_Vx.xx.pdf, Index is set to 0x0002, Subindex is set to 0x00, Length is set to 0x01, Data is set to 82,

and Control selects Write.

Precautions

 For ISDU operation, it is better to set Control to NULL first, fill Index, Subindex, Length, Data with data,

and then set Control.

 Read operations do not need to fill in Length, Data.

 After a write operation, the Error Code returns 0, indicating correctness, which can be verified by a

readback operation.

 If the operation returns an error code with a non-zero value, it indicates that an error exists, and the

problem can be localized by the meaning of the error code; see Appendix D for slave return error codes.

2、 PROFINET master configuration ISDU parameters

Due to the limitations of the protocol, PROFINET master does not support ISDU read operation, but

only supports ISDU write operation before configuration. If more than one write operation is needed, the

configuration operation can be issued several times, and the slave station usually supports saving the

configuration and does not lose the configuration when power is added.The difference between the ISDU

operation of the PROFINET master and the EtherCAT master lies in the fact that the Index, Subindex, and

Length fields of the PROFINET master can only be filled in with the decimal DEC value, and the Control

item is not needed.

Example 1: Same requirements as above, Index is set to 66 (0x0042), Subindex is set to 0 (0x00),

Length is set to 2 (0x02), and Data is set to 00FF.
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Example 2: The requirements are the same as above, Index is set to 73 (0x0049), Subindex is set to 0

(0x00), Length is set to 16 (0x10), and Data is set to 050505050505050508080808080808080808.

Example 3: The requirements are the same as above, with Index set to 2 (0x0002), Subindex set to 0

(0x00) 0x00, Length set to 1 (0x01), and Data set to 82.

 The ISDU configuration function of the EtherCAT master takes the TwinCAT3 software as an

example to introduce the configuration method, and the specific steps are described in detail in

the parameter configuration in chapter 7.2.1.

 The PROFINET master ISDU configuration function introduces the configuration method using

the TIA Portal V17 software as an example, and the specific steps are described in detail in the

ISDU parameter configuration in chapter 7.3.1.
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7.1.3 DI/DO /IO-Link mode function

1、 Port DI/DO mode

 Series 01 EtherCAT, PROFINET master each port Pin2 does not support the DO function, does not

support the configuration, the default standard DI mode. PROFINET master reserved Pin2

configuration items, but not operable.

 Each port Pin4 of 01 series EtherCAT and PROFINET master supports standard DI/DO modes, you

can select the corresponding standard DI and standard DO modes in the module, and the default

standard DI mode.

 The EtherCAT master takes the TwinCAT3 environment as an example. The port standard DI mode,

the process data is embodied in Digital Inputs Mapping, and the port standard DO mode, the process

data is embodied in Digital Outputs Mapping.

 Standard DI/DO mode for PROFINET master ports, refer to Appendix E for process data.

2、 Port IO-Link Mode

 Each port of the 01 series EtherCAT and PROFINET master supports IO-Link mode.

 Take TwinCAT3 environment as an example, after the port is configured in IO-Link mode, you can

check the "TxPDO IO-Link Status" to get the status of the port configuration, and the definition of the

status is shown in Appendix B.

 Under normal circumstances, the slave process data length should be consistent with the

configuration of the corresponding module data length, but also compatible. For example, if the slave

process data is input 2 bytes, the module can also choose to input more than 2 bytes, such as input 4

bytes; however, it can not choose to input less than 2 bytes, and the device status will indicate that the

input length does not match.

 If you do not obtain the slave device input and output process data length before configuring the

IO-Link mode, and you are not sure how to select the corresponding module, the EtherCAT master, for

example, in the TwinCAT3 environment, can view the port Info information by selecting any module

and the device re-enters the OP state.

For example, port 0, where 9000:24 displays the length of real input process data read by the

master from the slave, and 9000:25 displays the length of real output process data read by the master

from the slave, and the length value refers to Appendix C. If there is no corresponding slave data

length module, you can select a module with a length value greater than the slave data length; or

customize the data length module according to 7.5, and select the slave data length module. length

module according to 7.5 Customized Data Length Module.

 The DI/DO/IO-Link mode function of the EtherCAT master is described in the TwinCAT3 software

as an example of how to configure it. For details of the steps, see DI/DO/IO-Link Settings in

chapter 7.2.1.
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 The PROFINET master DI/DO/IO-Link mode function introduces the configuration method using

the TIA Portal V17 software as an example, and the specific steps are described in the

DI/DO/IO-Link settings in chapter 7.3.1.



IOL7 Series Master User's Manual 7 Operation

26 Copyright © 2024 Nanjing Solidot Electronic Technology Co., Ltd.

7.2EtherCAT Master Configuration Application

7.2.1 Application in TwinCAT3 software environment

1、 Preparation

 hardware environment

 Module Model IOL7-EC01B-8A

X00 port access to IOL7 slave module IOL7-16CB-M12

 A computer with pre-installed TwinCAT3 software

 Shielded cables for EtherCAT

 One switching power supply

 Device Configuration Files

Configuration file access: https://www.solidotech.com/documents/configfile

 Hardware configuration and wiring

Follow "5 Installation and Wiring".

2、 Preset Profiles

Place the ESI configuration file (Solidot EC IO-Link Gateway ESI V1.0.2.xml) in the TwinCAT installation

directory under "C:\TwinCAT\3.1\Config\Io\EtherCAT" as shown below.

https://www.solidotech.com/documents/configfile
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3、 Create Project

a. Click the TwinCAT icon in the lower right corner of the desktop and select "TwinCAT XAE (VS xxxx)"

to open the TwinCAT software as shown below.

b. Click "New TwinCAT Project", in the pop-up window, "Name" and "Solution name" correspond to

the project name and solution name respectively. In the pop-up window, "Name" and "Solution

name" correspond to the project name and solution name, respectively, and "Location"

corresponds to the project path, and these three items can be selected by default, then click "OK",

the project is created successfully, as shown below.
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4、 scanning device

a. After creating the project, right-click on the "Scan" option under "I/O -> Devices" to perform a

slave device scan, as shown below.

b. Check the "Local Connection" box, as shown below.
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c. Click on the pop-up window "Scan for boxes" and select "Yes"; click on the pop-up window

"Activate Free Run" and select "Yes". "Yes", as shown in the figure below.

d. After scanning the device, you can see Box1 in the left navigation tree, and you can see TwinCAT in

the "OP" state in the "Online" section, and you can observe that the RUN light of the slave device is

always on, as shown in the figure below.



IOL7 Series Master User's Manual 7 Operation

30 Copyright © 2024 Nanjing Solidot Electronic Technology Co., Ltd.

5、 DI/DO/IO-Link Settings

a. Master port 0 has been connected to the slave module IOL7-16CB-M12, check the IOL7-16CB-M12

power lamp, the power lamp is always on.

b. Click "Slots" in the right side configuration interface of the master station, select IO-Link Port 0 and

click "Delete", as shown below.

c. After the deletion is completed, select "IOL_I/O_02/02 byte" on the right side, and click the "<"

button to move left, as shown below. (Note: The IOL7-16CB-M12 can be configured with a

maximum of 16 channels of input or 16 channels of output, so select IOL_ I/O _ 02/02 byte.)
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d. After adding, Port0~7 on the left side is shown as below. Other port configuration DI/DO/IO-Link

method is the same as the method here.

e. After the configuration is complete, you need to perform Reload operation, click the menu bar

"TWINCAT -> Reload Devices" option, as shown below.
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f. After the Reload operation is completed, the device enters the OP state again. Click "TxPDO

IO-Link Status" in the left navigation tree to check, "Device Status of Port 0" value is 3, which

means IO-Link communication is normal, as shown in the figure below. See Appendix B for the

definition of port status. Check that the channel indicator of port 0 of the master is always on, and

the slave operation indicator is blinking periodically.

6、 Parameterization

a. Click "Startup" in the right configuration interface of the master station, you can see the

parameters and parameter values of the master module IOL7-EC01B-8A, including the 7-port Pin4

port output clear hold function and the IOL related setting information of the 7 interfaces, as

shown below
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b. Click "New" at the bottom of the "Startup" interface to enter the "Edit CANopen Startup Entry"

interface, as shown below.
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c. Configuration method of output clear/hold function: Take Port 0 Pin 4 as an example, click "New"

to enter the interface of "Edit CANopen Startup Entry", and double click "8200:01" to configure the

clear/hold function, as shown below. Click "New" to enter the "Edit CANopen Startup Entry"

interface, double-click "8200:01" to configure the clear/hold function, as shown in the figure below.

After the configuration is completed, click "OK".

d. ISDU function configuration method: Take Port 0 for example, click "New" to enter "Edit CANopen

Startup Entry" interface, double click "8100:01" and other parameters to configure. Double click

"8100:01" and other parameters to configure, as shown in the figure below.
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e. ISDU function to configure the port direction as an example, the 16 channels of IOL7-16CB-M12

are all in input mode by default, configure them to the first 8 channels as input and the last 8

channels as output. Refer to "IOL7 Series Hub User's Manual_Vx.xx.pdf" section 6.5.2, Index is

set to 0x0042, Subindex is set to 0x00, Length is set to 2(0x02), Data is set to 00FF, Control selects

Write, and then configure the IOL ISDU Config in order. Configure the parameters below Port 0 as

shown in the figure below. After the configuration is completed, click "OK".

f. After the output clear/hold function, ISDU function and other parameters are set, you need to

perform Reload operation, click "TWINCAT -> Reload Devices" option in the menu bar, as shown

below.
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7、 Function verification

a. In the left navigation tree, the port standard DI mode, the process data is reflected in Digital Inputs

Mapping; the port standard DO mode, the process data is reflected in Digital Outputs Mapping;

the port IO-Link mode, the process data is reflected in Module 1->PD In/Out, as shown below.

b. Take master X00 port to access IOL7 slave IOL7-16CB-M12, configure the first 8 channels of

IOL7-16CB-M12 to be input and the last 8 channels to be output for example, Input Byte 0

indicates the input signal value of slave module X00~X03, Output Byte 1 indicates the output

signal value of slave module X04~X07. Write "255" in Output Byte 1, and you will see the 8 channel

indicators of slave module X04~X07 light up, as shown in the figure below.
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c. When a valid voltage is input to the slave module X00, the input value "192" can be monitored in

Input Byte 0 as "2#11000000", as shown in the figure below.
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7.2.2 Application in CODESYS V3.5 software environment

1、 Preparation

 hardware environment

 Module model IOL7-EC01B-8A for example

X00 port access to IOL7 slave module IOL7-16CB-M12

 A computer with CODESYS V3.5 pre-installed, CODESYS Control Win V3 - x64 SysTray

software

 Shielded cables for EtherCAT

 One switching power supply

 Device Configuration Files

Configuration file access: https://www.solidotech.com/documents/configfile

 Hardware configuration and wiring

Follow "5 Installation and Wiring".

2、 Installing a device configuration file

a. Log in to CODESYS.

b. Select "Tools -> Device Repository".

c. Click "Install", select the relevant XML file for installation, the file format is Solidot EC IO-Link

Gateway ESI V1.0.2.xml. Successful installation shows "Device xxxx has been installed to the device

repository. Successful installation displays "Device xxxx has been installed to the device repository",

as shown below.

https://www.solidotech.com/documents/configfile
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3、 New Project

Click "File -> New Project" as shown below.

4、 Scanning network

a. To start the PLC with "CODESYS Control Win V3 - x64 SysTray", locate "CODESYS Control Win V3 -

x64 SysTray" in the lower right hand corner of the computer and Right-click on "CODESYS Control

Win V3 - x64 SysTray" in the lower right corner of the computer and select "Start PLC".

b. Double-click "Device (CODESYS Control Win V3 X64)" in the left navigation tree of CODESYS, and

click "Scan Networks".

c. Select the device and choose the correct controller network path as shown below.
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5、 Add EtherCAT Master

Right-click "Device(CODESYS Control Win V3 X64)" in the left navigation tree of CODESYS, click "Add

Device", select "EtherCAT -> Master -> EtherCAT Master" and add it.

6、 Configuring the EtherCAT Master

Double click "EtherCAT_Master(EtherCAT Master)" in the left navigation tree to open the right main

menu, click "Browse" and select Ethernet.
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7、 Scanning device

a. Before scanning for the first time, you must log in the program to PLC, right-click

"EtherCAT_Master(EtherCAT Master)" in the left navigation tree to select the scanning device, after

scanning to the corresponding device, select the module, click "Copy to project", as shown below.

b. After successful copying, it is shown below.
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8、 Test IO Module

a. To configure the IO module bus mode, select IO-Link_Port_0, right-click "Plug Device", and select

IO-Link 2 Byte Process Data Input /2 Byte Process Data Output, as shown below.

b. Click "Online -> Logout" in the menu bar to exit the PLC as shown below.
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c. Check "EtherCAT I/O Mapping" in the menu folder of the module IOL7-EC01B-8A.

d. In the "Always update variables" menu at the bottom right corner of the page, select the "Enabled

1" mode, as shown below.

e. Double click on IO-Link_Port_0 and select "EtherCAT I/O Mapping" in the menu folder.

f. In the "Always update variables" menu at the bottom right corner of the page, select the "Enabled

1" mode, as shown below.
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g. Log back in and run the software and test the module as shown below.
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7.2.3 Application in Sysmac Studio software environment

1、 preliminary

 hardware environment

 Module model number IOL7-EC01B-8A for example

X00 port access to IOL7 slave module IOL7-16CB-M12

 One computer with Sysmac Studio software pre-installed

 One Omron PLC

This description is based on model NJ301-1100 as an example.

 Shielded cables for EtherCAT

 One switching power supply

 Device Configuration Files

Configuration file access: https://www.solidotech.com/documents/configfile

 Hardware configuration and wiring

Follow "5 Installation and Wiring".

 Computer IP requirements

Set the IP address of the computer and the IP address of the PLC to make sure they are on the

same network segment.

2、 New Project

a. Open the Sysmac Studio software and click "New Project".

 Project name: customization.

 Select device: "Device" selects the corresponding PLC model, and recommend selecting "Version"

V1.40 and above.

b. When you have finished entering the project properties, click “Create”.

https://www.solidotech.com/documents/configfile
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c. Click "Controller -> Communication Settings" in the menu bar, select the method to be used every

time you connect to the controller when you are online, and enter "Remote IP Address" as shown

below.

d. Click "Ethernet communication test", the system shows that the test is successful.

3、 Installation of XML files

a. Expand "Configurations and Setup" in the left navigation tree and double-click on "EtherCAT".

b. Right-click on "Master" and select "Display ESI Library" as shown below.
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c. In the pop-up "ESI Library" window, click "Install (file)", select the XML file path, click "Yes" to

complete the installation.

4、 Add Device

There are two ways to add devices: online scanning and offline adding, and this note introduces

offline adding as an example.

a. Under the "Toolbox" column on the right, click to expand all suppliers and select "Nanjing Solidot

Electronic Technology Co. Ltd.", as shown below.
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b. Click "Solidot EC IO-Link Gateway" to select the product serie, and select the product model at the

bottom, double click "IOL7-EC01B-8A" to add the device, as shown below.

5、 Setting the node address

a. Click "Controller -> Online" in the menu bar to turn the controller to online status, as shown below.
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b. Right-click on the master device, click and select "Write Slave Device Node Address" as shown

below.

c. In the Set Node Address window, click the value under Set Value, enter the node address, and click

Write to change the slave device node address, as shown below.

d. Power down and reboot the slave device when prompted after the node address is successfully

written.
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6、 DI/DO/IO-Link Settings

a. In the offline state, in the EtherCAT main page, click to select "IOL7-EC01B-8A", and then click "Edit

Module Configuration" on the right side menu, as shown below.

b. In the Module Configuration page, you can see the function of the master port 0~7. You can

update the DI/DO/IO-Link configuration in the toolbox on the right side, as shown below.
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c. Take the X00 port of master module IOL7-PN01B-8A connected to IOL7-16CB-M12 module as an

example to introduce the DI/DO/IO-Link configuration method. Right-click "Digital-DI (M1)" and

select "Delete", then find the slave module under "Toolbox" on the right side, and double-click

"IOL_I/O_02/02". IOL_I/O_02/02 byte" to add IOL7 slave to the configuration, as shown below.

(Note: IOL7-16CB-M12 can be configured up to 16 channels input or 16 channels output, so

choose 02/02 byte.)

7、 Module Parameter Configuration

a. Offline, in the EtherCAT main page, click to select "IOL7-EC01B-8A", and then click "Edit Setting

Parameters " on the right side menu, as shown below.
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b. In the Initialization Parameter Setting page, you can configure the output clear hold function for

master ports 0~7 as shown below.

c. In the EtherCAT main page, click to select "IOL7-EC01B-8A", and then click "Edit Backup Parameter

Settings" in the right menu, as shown below.
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d. In the Backup Parameter Setting page, you can view the IO-Link information of the master ports

0~7, as shown below.

8、 Download configuration to PLC

a. In online status, click "Controller -> Transfer in (A) -> To Controller (T)" in the menu bar, as shown

below.
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b. Pop-up transmission confirmation window, click "Execute", and then click "Yes / OK", as shown in

the figure below, after the download is complete, you need to re-power.

9、 Viewing Functions

a. After restarting the power, you can see the PLC is in operation mode in the lower right corner,

double click "I/O Map" in the navigation tree on the left side, you can monitor the input/output

signals and force them to be output, as shown in the figure below.

 Digital Outputs Mapping_Outputs Pin 4_7100_01 Output value of Pin4 port of master

Port0~7

 Digital Inputs Mapping_Inputs Pin 2_6100_01 Input value of Pin2 port of master Port0~7
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 Digital Inputs Mapping_Inputs Pin 4_6100_02 Input value of Pin4 port of master Port0~7

 The Input and Output below the IOL_I/O_02/02 byte in slot 0 are the input and output values

of the slave.

b. Master Port0 access slave IOL7-16CB-M12 for IO-Link mode, Port1~3 for DI mode, Pin4 of Port4~7

for DO mode, as an example to introduce the input/output viewing function, as shown below.

c. In the "I/O Map" page, expand "Digital Outputs Mapping_Outputs Pin 4_7100_01", write "1" at

"Value" of Port4~7, and you can see that the indicator of Pin4 of IO-Link master device lights up as

shown below. Write "1" in the "Value" of Port4~7, and you can see that the Pin4 indicator of

Port4~7 of IO-Link master device lights up, as shown below.
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d. When the X00 port of the slave IOL7-16CB-M12 has a valid voltage input, it can be observed in "PD

In_Input Byte 0_6000_01" under IOL_I/O_02/02 byte in "I/O Map", as shown in the figure below.
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7.3PROFINET Master Configuration Application

7.3.1 Application in TIA Portal V17 software environment

1、 preliminary

 hardware environment

 Example of module model number IOL7-PN01B-8A

X00 port access to IOL7 slave module IOL7-16CB-M12

 One computer with pre-installed TIA Portal V17 software

 Shielded cables for PROFINET

 One Siemens PLC, this description takes Siemens S7-1200 CPU 1214C DC/DC/DC as an

example

 One switching power supply

 Device Configuration Files

Configuration file access: https://www.solidotech.com/documents/configfile

 Hardware configuration and wiring

Follow "5 Installation and Wiring".

2、 New construction

a. Open TIA Portal V17 software, click "Create New Project", enter the information and click "Create",

as shown below.

 Item name: customizable, can be left as default.

 Path: the project keeps the path, which can be left as default.

 Version: can be left as default.

 AUTHOR: The default can be maintained.

 Note: Customizable, may not be filled in.

https://www.solidotech.com/documents/configfile
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3、 Adding a PLC controller

a. Click “Configure a device”, as shown below.

b. Click "Add New Device", select the PLC model you are currently using, and click "Add", as shown

below. After adding, you can see that the PLC has been added to the device navigation tree.
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4、 Scanning connected devices

a. Click "Online Access -> Update Accessible Devices" in the left navigation tree as shown below.

b. When the update is complete, the connected slave devices are displayed, as shown below.

The IP address of the computer must be in the same network segment as the PLC, if not, modify

the IP address of the computer and repeat the above steps.
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c. Double-click "Online & Diagnostic" under Slave Devices in the left navigation tree, and you can

assign the IP address and configuration name of the current slave under the "Function" menu.

Click "Assign IP Address", fill in "Subnet Mask", then "IP Address", and click "Assign IP Address" at

the bottom. Click "Assign IP Address" at the bottom of the screen, as shown in the figure below.

d. Click "Assign PROFINET Device Name", fill in "PROFINET Device Name", and click "Assign Name",

as shown below.



IOL7 Series Master User's Manual 7 Operation

61 Copyright © 2024 Nanjing Solidot Electronic Technology Co., Ltd.

5、 Adding a GSD Configuration File

a. In the menu bar, select "Options -> Manage General Station Description Files (GSDML) (D)".

b. Click “Source Path” to select the folder where the GSD file is stored.

c. Check if the status of the GSD file you want to add is "Not yet installed", click “Install” if it is not

installed, or “Cancel” if it is already installed to skip the installation step.

6、 Adding Slave Devices

a. Double-click on "Devices & Networks" in the left navigation tree.

b. Click the "Hardware Catalog" vertical button on the right, the catalog is displayed as shown below.
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c. Locate the "IOL7-PN01B-8A" module in the hardware directory, drag or double-click the

"IOL7-PN01B-8A" module to the "Network View", as shown below. The following figure shows. If

you want to connect more than one module, you can add modules according to the actual

topology under "Hardware Catalog" on the right side.

d. Click "Unassigned (blue font)" on the slave device and select "PLC_1.PROFINET Interface_1" as

shown below.

e. When the connection is complete, it is shown in the following figure.
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f. Click the device name to rename the device, as shown below.

7、 DI/DO/IO-Link Setting

a. Click "Device View" to enter the device overview, you can see the topology configuration

information, including the I/O address automatically assigned by the system, the I/O address can

be changed by yourself, as shown below.Standard Input ~ Standard Input 7 can be configured

DI/DO/IO-Link.

b. When configuring DI/DO of master module IOL7-PN01B-8A, select X00~X07 ports corresponding

to Standard Input ~ Standard Input 7, right-click to delete, and then double-click to add Standard

Input/Standard Output under "Hardware Catalog" on the right side. Standard Output, as shown in

the figure below.
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c. The X00 port of the master module IOL7-PN01B-8A is connected to the IOL7-16CB-M12 module,

find the module under the "Hardware Catalog" on the right side, right-click on "Standard Input"

and select "Delete". Right click on "Standard Input" and select "Delete", then double click on

"IOL_I/O_02/02 byte" to add IOL7 slave to the configuration, as shown in the figure below. (Note:

IOL7-16CB-M12 can be configured up to 16 channels input or 16 channels output, so select 02/02

byte.)

8、 Assign device name

a. Switch to "Network View", right-click the connection cable between PLC and module

IOL7-PN01B-8A, and select "Assign Device Name" as shown below.
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b. The "Assign PROFINET Device Name" window pops up as shown below.

Check to see if the MAC address on the module silkscreen is the same as the MAC address of the

assigned device name.

 PROFINET device name: Name set in "Assign PROFINET device name".

 Type of PG/PC interface: PN/IE.

 PG/PC interface: the actual network adapter used.

c. Select the slave device in turn, click “Update List”, and click “Assign Name”. Check whether the

status of the node is "OK" in "Accessible nodes in the network", as shown below.

d. Click “Close”.
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9、 Download Configuration Structure

a. In “Network View”, check PLC.

b. Click the button in the menu bar to download the current configuration to the

PLC.

c. In the pop-up interface of "Extended Download to Device", the configuration is shown in the

following figure.

d. Click "Start Search" as shown below.

e. Click on "Download".
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f. Select "Continue without synchronization" as shown below.

g. Select "Stop All".

h. Click “Load”.

i. Click “Finish”.

j. Power on the device again.
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10、 Communication connection

a. Click the button, and then click "Go Online", the icons are green, that is, the

connection is successful, as shown in the figure below.

11、 Master Parameter Configuration

a. Open "Device View", in the offline state, right-click the module name "IOL7-PN01B-8A", click

"Properties", as shown below.
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b. In the property page, click "Module Parameters", as shown below. Parameters can be configured

according to the actual use of the need to configure, after the completion of the configuration,

re-download the program to the PLC, the PLC and the module need to be re-powered.

c. Setting method of clear hold function: Take Port 0 Pin 4 as an example, in the parameter page of

module IOL7-PN01B-8A, click the radio box on the right side of "Safe state Port 0 Pin 4" to set the

selection, as shown below. After the configuration is completed, re-download the program to PLC,

PLC and module need to be re-powered.
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12、 Slave ISDU Parameter Configuration

a. In the “Device View” page, right-click the slave module name "IOL_I/O_02/02 byte" in the offline

state, and then click “Properties”, as shown below.

b. In the property page, click "Module Parameters", as shown below. Parameters can be configured

according to the actual use of the need to configure, after the completion of the configuration,

re-download the program to the PLC, the PLC and the module need to be re-powered.
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c. To configure the IOL7-16CB-M12 with the first 8 channels as inputs and the last 8 channels as

outputs, for example, refer to section 6.5.2 of the IOL7 Series Hub User's Manual_Vx.xx.pdf, and

you need to set the Index setting to 66 (0x0042), the Subindex setting to 0 (0x00), and the Length

setting to 2 (0x02), Data is set to 00FF, as shown below. After the configuration is complete,

re-download the program to the PLC, the PLC and module need to be re-powered.

13、 Functional verification

a. Expand the left side of the project navigation, select "Watch and force tables", as shown below.
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b. Double-click "Add New Watch Table", the system adds a new watch table, as shown below.

c. Open the “Device View” and check the channel Q address (channel address of the output signal)

and I address (channel address of the input signal) of the master module IOL7-PN01B-8A and the

channel Q address (channel address of the output signal) and I address (channel address of the

input signal) of the slave module IOL_I/O_02/02 byte in the device overview. address (channel

address of the input signal) of the slave module IOL_I/O_02/02 byte.

For example, the "Q address" of IOL7-PN01B-8A module is 2 and "I address" is 2~13; the "Q

address" of slave module IOL_I/O_02/02 byte is 64~65 and "I address" is 68~69, as shown in the

figure below. The "Q address" of the slave module IOL_I/O_02/02 byte is 64~65, and the "I

address" is 68~69, as shown in the figure below.

IB2 of the master module IOL7-PN01B-8A indicates the monitoring value of Pin2 input signal of

X00~X07, IB3 indicates the monitoring value of Pin4 input signal of X00~X07, and IB4~IB13

indicate the parameter information; by default, the I/O interfaces of the master module are all

input channels, and when there are interfaces of the master module configured as output

channels, QB2 indicates the Pin4 output signal of X00~X07. QB2 indicates the Pin4 output signal

of X00~X07 when the master module has interface configured as output channel.
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d. Fill in the address cell of the monitoring table with the address of the input and output channels,

press the Enter key, and then click the button to monitor the data, as shown below.

e. Take the configuration of IOL7-16CB-M12 that the first 8 channels are inputs and the last 8

channels are outputs as an example, IB68 represents the input signal value of slave module

X00~X03, and QB65 represents the output signal value of slave module X04~X07. Input "FF" in the

"Modify Value" cell of QB65, click button to write, and see the 8 channel indicators of slave

module X04~X07 light up, as shown below.
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f. When the slave module X00 inputs a valid voltage, the input value "16#C0" can be monitored in

IB68 as "2#11000000" as shown in the figure below.
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7.3.2 Application in STEP 7-MicroWIN SMART software environment

1、 Preliminary

 hardware environment

 Module Model IOL7-PN01B-8A

X00 port access to IOL7 slave module IOL7-16CB-M12

 A computer with pre-installed STEP 7-MicroWIN SMART V2.6 software

 Shielded cables for PROFINET

 One Siemens PLC, this description takes Siemens S7-200 SMART for example

 One switching power supply

 Device Configuration Files

Configuration file access: https://www.solidotech.com/documents/configfile

 Hardware configuration and wiring

Follow "5 Installation and Wiring".

2、 Add PLC

a. Open the STEP 7-MicroWIN SMART software.

b. Double-click the button on the left navigation tree to bring up the "System Block"

window, select the CPU model corresponding to the PLC, and click "OK", as shown below.

https://www.solidotech.com/documents/configfile
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c. Click the button on the left navigation tree to bring up the "Communications" window,

switch the communication interface to the interface actually used by the PLC, and click "Find CPUs"

to find the PLC, as shown below.

d. Click "Edit" in the communication window, the Edit button is switched to the Set button, the IP

address input box is lit, modify the IP address and the IP address of the computer interface with

the same network segment, modify the completion of the click on the "Set" again, click "OK" after

the completion of the settings, as shown below. Click "OK", as shown below. Note: You can only

modify the IP address of the computer's Ethernet interface, and the PLC address can be the same

network segment.
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3、 Importing GSD files

a. Click "File -> GSDML Management" in the menu bar, click "Browse" in the GSDML management

window, and select the GSDML file to be imported file and click "OK", as shown in the figure below.

4、 Find Equipment

a. Click the menu bar "Tools -> Find PROFINET devices", pop-up window to find PROFINET devices,

switch the communication interface for the actual use of the PLC interface, click "Find devices", as

shown below.
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b. Click "Edit" to edit the module name, after editing, click "Set", as shown in the figure below.

5、 Configuration of PROFINET networks

a. Click "Tools -> PROFINET" in the menu bar to open the PROFINET Configuration Wizard.

b. On the PROFINET Configuration Wizard page, select the role of the PLC as "Controller" as shown

below.
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c. Click Next to enter the Controller Configuration page, add a device from the device catalog tree on

the right, select IOL7-PN01B-8A, and click Add, as shown below.

d. Double-click the input box below the device name to enter the device name, which needs to be

the same as the name set when finding the device; double-click the input box below the IP address

to enter the IP address, and when the input is completed, it is shown in the following figure. If

there are other modules in the configuration, you can add and configure other modules in the

same way.

Note: The device name needs to be the same as the module name, and the IP address needs to

be set in the same network segment as the PLC.
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e. Click "Next", the network configuration is complete, as shown in the figure below, you can see that

the starting address of the module's inputs and outputs are all 128.

6、 DI/DO/IO-Link Settings

a. Master port 0 has been connected to the slave module IOL7-16CB-M12, check the IOL7-16CB-M12

power lamp, the power lamp is always on.

b. In the PROFINET Configuration Wizard interface , check "Standard Input 1 2", that is, select IO-Link

Port 0 and click "Delete", as shown below.
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c. After deleting, select "IOL_ I/O_02/02 byte" on the right side, click "Add" or select and drag it to

Port 0, as shown below. (Note: The IOL7-16CB-M12 can be configured with a maximum of 16

channels of input or 16 channels of output, so select IOL_ I/O_02/02 byte).

d. In the same way, configure Port4~7 as "Standard Output", after the configuration is completed,

the left Port0~7 is shown in the following figure. The configuration method of other ports

DI/DO/IO-Link mode is the same as here.

e. Click "Generate" to complete the configuration of the configuration network; or click "Next" to

configure the parameters.
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7、 Parameter Configuration

a. After completing the DI/DO/IO-Link settings, click "Next" in the PROFINET Configuration Wizard

interface to view and configure the parameters as shown below.

b. Scroll down the Master Configuration page to configure the Output Clear Hold function as shown

below.
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c. Switch to the Slave Configuration page to enable ISDU configuration, as shown below.

d. Click Next and Generate to complete the configuration of the network and parameters, as shown

below.
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8、 download program

a. Click the menu bar "File -> Download", the download window pops up, click "Download", as

shown in the figure below.

b. When the download window indicates that the download has been successfully completed, click

"Close".

Note: After the download is complete, power the module back up for processing.
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9、 Functional verification

a. Click "PLC -> RUN" in the menu bar, a confirmation window will pop up, click "Yes" to confirm, as

shown below.

b. Click "Status Chart -> Chart 1" in the left navigation tree, and input the corresponding channel

address and data format in Chart 1, you can perform forced output and input monitoring

operation for IO module here.
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c. In the new value input box corresponding to QB128 in the output line of the status chart, you can

write the output value, such as writing "15", then the value of Pin4 output channel of Port4~7 will

be set to 1, and the lamps of Pin4 output channel of Port4~7 will all light up. When there is a valid

voltage input to the input channel of Pin2 port of X07 of the slave module, the input value can be

monitored in IB145, as shown below.

Note: In this example, the master X00 port access slave module is set to IO-Link mode, Pin2 of

X01~X07 and Pin4 of X01~X03 are set to DI mode, and Pin4 of X04~X07 are set to DO mode.

IB128 is the address of Pin2 port input channel monitoring for masters X01~X07, IB129 is the

address of Pin4 port input channel monitoring for masters X01~X03, and QB128 is the address of

Pin4 port output channel monitoring for masters X04~X07.

QB133 is the output channel monitoring address of slave devices X00~X03, QB134 is the output

channel monitoring address of slave devices X04~X07, IB144 is the input channel monitoring

address of slave devices X00~X03, and IB145 is the input channel monitoring address of slave

devices X04~X07.
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7.4EtherNet/IP Master Configuration Application

To be added.

7.5Customized Data Length Module

Appendix A in different protocols master defined different byte length of the process data module,

these modules basically meet the market mainstream slave equipment docking requirements, but the

actual use of some of the slave equipment used in the process data length can not be matched with the

module in the phenomenon. For example, a slave has an input process data length of 16 bytes and an

output process data length of 32 bytes; using an input process data length of 32 bytes and an output

process data length of 32 bytes can be compatible, or customized process data length. This section

describes how to customize the process data length.

7.5.1 EtherCAT Master Customization Module

1. Determine the slave process data length value, which can be obtained from the Port Info

information as described in chapter 7.1.4, or obtain such information from the slave manual;

2. Modify the configuration file to add modules, the module ID is defined as 0x0001xxyy, xx means

input process data length byte HEX value, yy means output process data length byte HEX value. Take

16 bytes input process data length 32 bytes output process data length as an example: module ID is

defined as 0x00011020; add support module ID in each slot of Device;

3. Restart TwinCAT by placing the configuration file in the TwinCAT installation directory according

to chapter 7.2.1;

4. Scan the device, update the device EEPROM, update successfully, power down and reboot.

7.5.2 PROFINET master customization module

In PROFINET master device configuration file, "module" is called sub-module, add customized

sub-module, sub-module ID is the same as EtherCAT module ID, modify the configuration file, and

update the GSD file of the host computer.

Precaution

 If you are not sure how to implement the customized data length module and modify the

configuration file, please consult the technical support first.
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8 FAQ

8.1Device cannot be found in the software

1. Verify that the ESI configuration file is installed correctly.

2. Verify that the ESI profile version is accurate.

3. Whether the TwinCAT software was restarted after installing the ESI configuration file or whether

Reload Device Descriptions was not performed.

8.2Device cannot enter OP state

1. Confirmation of the correct establishment of the project.

2. Confirm the settings related to the node station number.

3. Verify that the equipment is powered properly.

4. EtherCAT communication line is normal.

5. whether to re-power the device after changing the slave device node address.

8.3Device not found when updating accessible devices

1. Confirm that the PORTAL software is correctly installed.

2. Make sure that no other software is occupying the network adapter used by the PORTAL

software.

3. Confirm that the network cable, network card, and network port are working properly.

4. Verify that the IP address or MAC address is not in conflict.

8.4Load button is grayed out when downloading configuration

1. Verify that there are no mandatory values in the PLC.

2. Verify that the PLC is in the stopped state.
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9 Appendix

9.1Appendix A

Modules with different byte input process data lengths, output process data lengths, and combined

input/output process data lengths have been defined in the IOL7 series EtherCAT master and PROFINET

master configuration files and are listed in the table below:

Name Description

Std Input standard input

Std Output standard output

IOL_I_01 Byte Input process data length 1 byte

IOL_I_02 Byte Input process data length 2 bytes

IOL_I_04 Byte Input process data length 4 bytes

IOL_I_06 Byte Input process data length 6 bytes

IOL_I_08 Byte Input process data length 8 bytes

IOL_I_10 Byte Input process data length 10 bytes

IOL_I_16 Byte Input process data length 16 bytes

IOL_I_24 Byte Input process data length 24 bytes

IOL_I_32 Byte Input process data length 32 bytes

IOL_O_01 Byte Output process data length 1 byte

IOL_O_02 Byte Output process data length 2 bytes

IOL_O_04 Byte Output process data length 4 bytes

IOL_O_06 Byte Output process data length 6 bytes

IOL_O_08 Byte Output process data length 8 bytes

IOL_O_10 Byte Output process data length 10 bytes

IOL_O_16 Byte Output process data length 16 bytes

IOL_O_24 Byte Output process data length 24 bytes

IOL_O_32 Byte Output process data length 32 bytes

IOL_I/O_01/01 Byte Input process data length 1 byte, output process data length 1 byte

IOL_I/O_02/02 Byte Input process data length 2 bytes, output process data length 2 bytes
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IOL_I/O_02/04 Byte Input process data length 2 bytes, output process data length 4 bytes

IOL_I/O_02/08 Byte Input process data length 2 bytes, output process data length 8 bytes

IOL_I/O_04/02 Byte Input process data length 4 bytes, output process data length 2 bytes

IOL_I/O_04/04 Byte Input process data length 4 bytes, output process data length 4 bytes

IOL_I/O_04/08 Byte Input process data length 4 bytes, output process data length 8 bytes

IOL_I/O_04/16 Byte Input process data length 4 bytes, output process data length 16 bytes

IOL_I/O_04/32 Byte Input process data length 4 bytes, output process data length 32 bytes

IOL_I/O_08/02 Byte Input process data length 8 bytes, output process data length 2 bytes

IOL_I/O_08/04 Byte Input process data length 8 bytes, output process data length 4 bytes

IOL_I/O_08/08 Byte Input process data length 8 bytes, output process data length 8 bytes

IOL_I/O_10/10 Byte Input process data length 10 bytes, output process data length 10 bytes

IOL_I/O_16/04 Byte Input process data length 16 bytes, output process data length 4 bytes

IOL_I/O_16/16 Byte Input process data length 16 bytes, output process data length 16 bytes

IOL_I/O_24/24 Byte Input process data length 24 bytes, output process data length 24 bytes

IOL_I/O_32/04 Byte Input process data length 32 bytes, output process data length 4 bytes

IOL_I/O_32/32 Byte Input process data length 32 bytes, output process data length 32 bytes



IOL7 Series Master User's Manual 9 Appendix

91 Copyright © 2024 Nanjing Solidot Electronic Technology Co., Ltd.

9.2Appendix B

The IO-Link port status is represented by 1 byte, where Bit0.... .3 indicate the IO-Link port status,

Bit4... .7 indicates the IO-Link port error indication, refer to chapter 7 of ETG.5001.6220 S (D) V1.0.5.pdf.

Bit0... .3 definitions:

Value (DEC) Description

0 Port inactivation

1 Port is in input mode

2 Port is in output mode

3 Port is in IO-Link mode, communication is normal

4 The port is in IO-Link mode and the communication is abnormal.

Bit4.... .7 definitions:

Value (DEC) Description

0 No error

1 watchdog anomaly (computing)

2 cache overflow

3 Invalid Device ID

4 Invalid vendor ID

5 Invalid IO-Link version

6 Null Framing Capability

7 Invalid cycle time

8 Invalid Input Process Data Length

9 Invalid output process data length

10 No equipment detected

11 PreOP status error

For example: the port is configured for IO-Link mode and the slave is not actually accessed. the status

prompts 0xA4. the port is configured for IO-Link mode but the length of the input process data does not

match. the status prompts 0x84. the port is configured for IO-Link mode but the length of the input

process data does not match.

The IO-Link master status is represented by 1 byte and is defined as follows:

Value (DEC) Description

0 No error

1 phase sequence

2 overpressurization

3 Overcurrent, overload

4...255 reservations
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9.3Appendix C

The 1-byte process data length defined in the IO-Link standard, different Bit indicates different

meanings, refer to Appendix B.1.6 of 《IOL-Interface-Spec_10002_V113_Jun19.pdf》.

Bit Description

0... .4 lengths

5 reservations

6 Whether standard input or standard output mode is supported

7 Byte marker bit, set, data length indicates 0.... .4 length value plus 1; not set, 0... .4

length value indicates the bit length.

Disregarding Bit6, the correspondence between its value and process data length is simply expressed

as follows:

Byte Description

0x01 Process data length 1 bit, normally used for standard inputs or standard outputs

0x08 Process data length 1 byte

0x10 Process data length 2 bytes

0x18 Process data length 3 bytes

0x83 Process data length 4 bytes

0x84 Process data length 5 bytes

0x85 Process data length 6 bytes

0x86 Process data length 7 bytes

0x87 Process data length 8 bytes

0x88 Process data length 9 bytes

0x89 Process data length 10 bytes

0x8A Process data length 11 bytes

0x8B Process data length 12 bytes

0x8C Process data length 13 bytes

0x8D Process data length 14 bytes

0x8E Process data length 15 bytes

0x8F Process data length 16 bytes

0x90 Process data length 17 bytes

0x91 Process data length 18 bytes

0x92 Process data length 19 bytes

0x93 Process data length 20 bytes

0x94 Process data length 21 bytes

0x95 Process data length 22 bytes

0x96 Process data length 23 bytes

0x97 Process data length 24 bytes

0x98 Process data length 25 bytes

0x99 Process data length 26 bytes

0x9A Process data length 27 bytes
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0x9B Process data length 28 bytes

0x9C Process data length 29 bytes

0x9D Process data length 30 bytes

0x9E Process data length 31 bytes

0x9F Process data length 32 bytes

9.4Appendix D

It is possible for the slave ISDU to return an error, where the error code is defined as follows and can

be found in Appendix C ErrorTypes of 《IOL-Interface-Spec_10002_V113_Jun19.pdf》.

error code Description

0x8000 Device application layer error

0x8011 Non-fetchable indexes

0x8012 Non-fetchable subindexes

0x8020 Temporary unavailability of services

0x8021 Local control services temporarily unavailable

0x8022 Temporary unavailability of equipment control services

0x8023 privilege error

0x8030 Parameter crossing range

0x8031 Parameter crossing limit values

0x8032 Parameter is below the limit value

0x8033 Parameter length too long

0x8034 Insufficient parameter length

0x8035 Function unavailable

0x8036 Functions temporarily unavailable

0x8040 Invalid parameter set

0x8041 Inconsistent parameter sets

0x8082 The application is not ready

0x81xx Manufacturer Customization
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9.5Appendix E

Slot0 Data Definition Table for PROFINET Master Models IOL7-PN01B-8A and IOL7-PN01B-4A4B:

typology byte offset lengths Description

Input process data (12

bytes)

0 1 byte Port Pin2 Standard Input Mode

Input Value

1 1 byte Port Pin4 Standard Input Mode

Input Value

2 1 byte Port 0 Device Status

3 1 byte Port 1 Device Status

4 1 byte Port 2 Device Status

5 1 byte Port 3 Device Status

6 1 byte Port 4 Device Status

7 1 byte Port 5 Device Status

8 1 byte Port 6 Device Status

9 1 byte Port 7 Device Status

10 1 byte master state

11 1 byte Input data validity, default 0xFF,

reserved

Output process data (1

byte)

0 1 byte Port Pin4 Standard Output Mode

Output Value

Slot0 data definition table for PROFINET master IOL7-PN01B-8B model:

typology byte offset lengths Description

Input process data (11

bytes)

0 1 byte Port Pin4 Standard Input Mode

Input Value

1 1 byte Port 0 Device Status

2 1 byte Port 1 Device Status

3 1 byte Port 2 Device Status

4 1 byte Port 3 Device Status

5 1 byte Port 4 Device Status

6 1 byte Port 5 Device Status

7 1 byte Port 6 Device Status

8 1 byte Port 7 Device Status

9 1 byte master state

10 1 byte Input data validity, default 0xFF,

reserved

Output process data (1

byte)

0 1 byte Port Pin4 Standard Output Mode

Output Value
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